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Assignment 1: Intro to Healthy Living 
For students 

This assignment was created by the Arctic Institute of Community-Based Research for the Healthy Living in My 
Community Project, borrowing the format from the other assignments. 

  

Assignment Overview 
What ways am I healthy? There are many aspects to health and everyone has different ways that they 
are healthy. What is important is that we look after each of the different areas of our health, the 
physical, mental/intellectual, spiritual, social, and emotional. Some of the activities and behaviours 
may overlap with many different aspects of health and that is ok because these dimensions are 
related. For example, walking outside with friends improves our physical health and our emotional, 
spiritual and social health! 
 

Assignment Tasks 
Ask:  Personal Reflection 

Reflect on ways that you are healthy in the five key dimensions. Refer to Handout B for definitions.  

Acquire:  Fill out the Questionnaire 

1. What does ‘healthy’ mean to you?  

 

2. What are examples of ways that you are healthy physically (i.e. eating/nutrition, physical activity, 
muscles strength, free from illness)? What more could you do improve your physical health? 
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Assignment 1: Intro to Healthy Living 

 
3. What are examples of ways that you are healthy emotionally (i.e. feelings, self-esteem and self-

worth)? What more could you do to improve your emotional health? 
 

 

4. What are examples of ways that you are healthy spiritually (i.e. sense of self, values, 
connectedness to others, environment and/or higher being)? What more could you do to improve 
your spiritual health? 

 

5. What are examples of ways that you are healthy mentally/intellectually (i.e. thoughts, mindset, 
skills)? What more could you do to improve your mentally/intellectually? 
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Assignment 1: Intro to Healthy Living 

6. What are examples of ways that you are healthy socially (i.e. friends, family, community)? What 
more could you do to improve your social health? 

 

 
 

Publish:  Share your reflections with others 
 

1. In pairs or as a class share your reflections with others.  
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Assignment 2: Exploring Healthy Living in My Community 
For students 

This assignment was created by the Arctic Institute of Community-Based Research for the Healthy Living in My 
Community Project, borrowing the format from the other assignments. 

  

Assignment Overview 
What healthy living options are available in my community? This lesson focuses on exploring the 
healthy living inventory map in the Yukon created by the Arctic Institute of Community-Based 
Research (AICBR) (www.aicbr.ca). This tool identifies various healthy eating and active living programs 
(among other healthy living programs) in the territory. In this lesson you will walk through a story map 
showing you how to explore the Healthy Living Inventory Map and you will also learn how to get 
acquainted with the ArcGIS Online platform. 

The following link and tutorial should be referenced to help you complete the assignment: 

● [Story Map] Lesson 2: Healthy Living in My Community: https://arcg.is/0mHruz 
● Tutorial1-IntroArcGISOnline, Part A and B 

 

Assignment Tasks 
Explore:  Part 1 - Healthy Living 

Type in the URL of the story map to start this assignment. Walk through the story map and explore 
the map by scrolling through the page.  

URL: https://arcg.is/0mHruz 
 

Explore:  Part 2 – ArcGIS Online 

Walk through Tutorial 1-IntroArcGISOnline, Part A and B and log into your ArcGIS online account. 
Explore the content, map, gallery to familiarize yourself with the ArcGIS platform. Through the tutorial 
you will learn how to use basic features of the platform – i.e. where their content is, the gallery, how 
to open up a map, etc.  
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Assignment 3: Mapping My Community 
For students 

This assignment was originally created by K12 team at Esri Canada and modified 
by the Arctic Institute of Community-Based Research for the Healthy Living in My 
Community Project. 

  

Assignment Overview 
What makes a healthy community? There are various factors that can impact healthy living in our 
communities. These may include: access to parks and greenspace, hospitals and health care services, 
gardens or greenhouses, or healthy eating and physical activity programs, among others. 

Using your ArcGIS Online account walk through Tutorial1-IntroArcGISOnline, Parts C,D,E, and F to 
learn about how to create your first map. Then after you feel comfortable with how to create a basic 
map, follow along this assignment to add specific features about healthy living in your community. 
You can do this either on the same map you created in Tutorial1 or in a brand-new map.  

The following tutorial should be referenced to help you complete the assignment: 

● Tutorial1-IntroArcGISOnline – Parts C,D,E, and F 
● Video Tutorial (same as Parts C-F): 

https://www.youtube.com/watch?v=tL6j0EDTFv0&feature=youtu.be  
  
 

Assignment Tasks 
Ask:  Determine your Questions 

Reflect on ways that you are healthy. Think about what features there are in your community: 

a. Are there any parks in your community?  

b. Are there any healthy eating programs offered at a local church? To answer this, you 
may use the Internet to search. 

c. Is there a restaurant you go to eat with your family that offers healthy food?  

d. Are there any farms in your area? What about community gardens or backyard 
gardens? To answer this, search the internet (see suggested resources below) and/or 
interview peers, family, friends, neighbours.  

i. Yukon Agricultural Association Farm Products Guide: http://www.yukonag.ca/guide/  

ii. Healthy Living Inventory: https://www.aicbr.ca/healthy-living-inventory/  

You can decide to choose one feature (for instance, the walking trails at the park) and map it or map 
multiple features (trails and the healthy restaurant). You can build on the map you created in 
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Assignment 3: Mapping My Community 

Tutorial1 or you can start fresh from a new map, this will depend on how many different features and 
notes you want your map to show. 

Acquire:  Create your Map 

1. Tutorial 1 will walk you through how to create your first map – the following steps provide an 
overview of what you are supposed to do. 

2. Add features, (pins, lines, geographical areas) notes, links, and layers to your map. 

3. Think about places you eat, shop, walk, play, and learn, programs you are already involved in, 
etc. Search on the internet for photos or add ones you have taken, describe program info, add 
in personal stories in notes to your map. Draw lines, boundaries and other features signifying 
the healthy living aspects of your community (for example, parks or areas/paths you like to 
run/jog). 

4. Take a measurement of key features: 

a. In upper toolbar of your map viewer, click on 
measure. Choose the second icon to 
measure the length of the line. 

b. Go to the feature you want to measure (for 
example, a line), click once on the spot where 
you want to start measuring from, then move cursor along the length 
of the line; if the line or feature is curved, you can click once along the 
curve as you go to curve the measurement alongside the curved line. 
When you reach the spot where you want to stop the measurement at, double click 
and this is where the end of the measurement will be. 

c. The measurement will show up in the box in top right corner.  

d. Click on Measure box again to exit measure function. 

e. Make sure to save your map every few minutes. 

 

 

Publish:  Share your map with others 
 

1. Publish and share the map to your teacher’s classroom group in ArcGIS Online. 
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Assignment 4: Surveying My Community 
For students 

This assignment was originally created by K12 team at Esri Canada and modified 
by the Arctic Institute of Community-Based Research for the Healthy Living in My 
Community Project. 

 

Assignment Overview 
Using your ArcGIS Online account and Esri’s Survey123 application, you are tasked with creating a 
survey that you will use to gather data on the various healthy living features in your community. You 
might choose to develop the questionnaire based on one feature (say the paths behind your school) 
or you might want to have a broader questionnaire that can be used to gather information about 
multiple features (i.e. the paths, the restaurants you like to eat at, the lakes you like you swim in, your 
school, church, the farms or gardens in your area, etc.)  

The following tutorials should be referenced to help you complete the assignment (the tutorial can be 
done after you’ve developed your list of questions): 

● Tutorial2-Survey123 print out (30-45mins) 
  
The following resources can also be used to help you complete the assignment: 

● ‘AICBR: Healthy Living Inventory Map for Yukon’ - https://esricanada-ce.github.io/aicbr/2016/#yt 

● ‘AICBR: Healthy Living Inventory Map for NWT’ - https://esricanada-ce.github.io/aicbr/2016/#nwt 

● Yukon Agricultural Association Farm Products Guide: http://www.yukonag.ca/guide/  
 

Assignment Tasks 
Ask:  Determine your Questions 

Talk to your teacher about what specific questions you’d like to investigate and write them down on a 
blank piece of paper. Say you are interested in the paths behind your school. Think about what other 
information you would like to know about them. For example, “Who uses them; what times of the day 
are they busiest; why does this feature improve health?”  

Remember from Assignment 3 when you reflected on and mapped some of the different features in 
your community? In this Assignment, we are going to dive a bit deeper into those features and gather 
some more information about them as well as others.  
 
The questionnaire or “survey” you are creating is your investigation tool to explore your community a 
bit deeper.  
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Assignment 4: Surveying My Community 

 
You must have a minimum of 8 questions.  
Sample questions:  

• What feature are you interested in?  
• How does this feature promote (or inhibit) healthy living?  
• What areas of health does this activity promote? (i.e. mental, physical, emotional, spiritual 

health)? 
• What do you like about the feature? 
• What do you dislike about it? 
• Who uses the feature? 
• Where can people get more information about it? 

 
**Must include location question – if you want the survey to map out the program/activity/etc. on 
the map, you must include a question about location.   

• Where is the feature in the community? (see more below) 
 

Acquire:  Create your Survey and collect data 

1. Complete the Tutorial2-Survey123. 
2. Create a survey using Survey123 with the 8 or more questions you wrote down.  

a. **Remember: You must have a space to fill in the location, otherwise the survey 
responses will not get mapped.  

i. à Either: Include single line text, where the user of the survey can write in the 
exact street address.  

ii. à Or: Include a GEOPOINT question, which lets the user on the other end 
move the cursor around on the map and set the location visually. 

3. Publish and share the survey to your teachers’ classroom group in ArcGIS Online, if applicable. 
4. Conduct your survey. Fill out your survey a minimum of 10 times. This will mean there will be 

10 different data points that will show up on your map. Ask family and friends, neighbours 
and/or peers your questions or research on the internet to help fill in the data (using the 
resources above). Each time you fill in the survey, you will focus on a different healthy living 
feature (i.e. fill out the survey for each program/service/activity, etc. separately to create 
different data points on your map).  

5. Analyze and summarize your results (see below). 
 
Analyse:  Summarize your Results 
You can view and summarize the information you collected right in Survey123.  
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Assignment 4: Surveying My Community 

1. Return to Survey123 to view and summarize the information you collected for each question – 
by clicking Analyze tab. 

2. Create a Web map to visualize your results – by clicking Data tab and then “Open in Map 
Viewer”. Make sure you save this map version before closing. You may wish to add this map 
layer to the map you created in Assignment 3. Follow Tutorial1-IntroArcGIS, Part G to add 
layers to a map.   
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Assignment 5: Telling a Good Story 
For students 

  

This lesson was created by the Arctic Institute of Community-Based Research for the Healthy Living in My 
Community Project; borrowing the format of original assignments. 

 

Assignment Overview 
In this assignment, you will explore different stories and develop your plan for telling your story of 
healthy living in your community. You will reflect on what the elements there are to a good story and 
start planning your story map about healthy living.  

 

Part 1: Telling a Good Story 

Explore: References and Story Map Examples 

● Explore some of the background information and look at different story maps and get inspired: 

o Storytelling with Maps: http://storymaps.arcgis.com/en/  

o Story Map Journal: http://storymaps.arcgis.com/en/app-list/map-journal/ 

o Explore the Growing World of Story Maps: 
https://storymaps.arcgis.com/en/gallery/#s=0  

o Story Map Example: 
▪ Yukon youth runners: this story map was created by a Grade 12 Yukoner about 

the Yukon Youth runners program in Whitehorse: https://arcg.is/1avj8j0 (This is 
also an example of a finished story map created as part of this unit project) 

Learn: Tutorials 

The following links should be referenced to help you complete the assignment: 

● The Five Principles of Effective Storytelling - http://storymaps.arcgis.com/en/five-principles/  
 

Act: Class Discussion 

A story map is a great tool to communicate and share stories about the world and your experiences in 
it. They are a combination of maps, multi-media such as photos and videos, and text that are used to 
tell a story. As a class, you will first engage in a discussion about storytelling and what the aspects are 
to a good story.  

1. From the various examples of story maps, what are common elements that you see? 
2. Did you find a particular story that was most interesting? 

a. Why did you find it interesting? 
b. Were there elements to the story that were missing that you wished were there? 
c. Tell us about the story - the Who, What, When, Where, and Why? 

3. What are other ways you can tell a story and share it online? 
4. Which story map version did you like the best? Why was it effective at telling the story? 
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Assignment 5: Telling a Good Story 

Part 2: Planning Your Story 

Here, you will start to think about what story you want to tell about healthy living in your community. 
The following tutorial can be referenced to help you complete the assignment in Part 2 (i.e. to help 
you find a program in your community that you want to participate in) 

• Lesson 2 story map of Healthy Living in my Community: https://arcg.is/0mHruz 

Ask:  Personal Reflection 

• Reflect on what kind of story you want to tell. Consider how you can build off the maps you 
have already created in Lessons 3 and 4.  

Acquire:  Fill out your Planning Proposal 

1. What area of healthy living do you want to explore (i.e. Healthy Eating, Active Living, Mental 
Health, Cultural Activities, Other?)  

  

 

 

2. What program/activity/service do you want to focus on? (Choose 1) Why did you choose this 
program/activity/service? 

o Use the Healthy Living Inventory or choose from new features on the map you created of 
your community (Lesson 3). 

 

 

 

 

 

3. How will you gather more information about the chosen program/activity/service? (i.e. exploring 
Inventory and attending one of the programs, interviewing someone involved (by phone, email, in 
person?) and/or participating in an activity you are already involved in with friends, exploring a 
feature you found in your survey from Assignment 3 a bit more, etc.) 

 

 

4. What kinds of media do you want to include? (photos, video clips, sound clips, text, etc.) 
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Assignment 5: Telling a Good Story 

 

 

 

 

5. Who are the main characters in your story? (This could be you, your friends and/or family, or it 
could be someone else who is involved in the program/activity/service you have chosen) 

For example, if you choose a healthy eating theme and the program ‘community garden’, you may 
wish to interview someone who’s been involved in the garden from the start or who has a 
particular story you want to tell, or you might make it instructional about gardening. 

 

 

 

 

6. What areas of health does your program target? How are you going to integrate information 
about the background health aspects into your story? 

 

 

 

 

7. What story map version are you going to use to tell your story? 

 

8. What information are you going to collect and why – (i.e. what questions are you going to ask and 
to whom (if interviewing)) 

 
 

 

 

 

 

 

9. What kind of story do you want to tell? (i.e. a personal success/growth story? A motivational 
story? A story that teaches/helps others? A funny story? A sad story?) 
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Assignment 5: Telling a Good Story 

 

10. What is the title of your story? 

 

 

 

 

 

 

Publish:  Share your proposal and get feedback 
 

1. Share your proposal with your teacher and gather feedback. You might also want to do this in 
pairs with a peer.  

2. The story maps will be presented to the class after the project is completed. 

 

Next Steps: 

If you have not yet done so, you can walk through the following piece of the Tutorial 1 to learn how 
you can merge multiple maps (called “layers”) into one map – i.e. to combine maps that were created 
in Assignments 3 and 4 so that you can later add them to your story map.  

• Follow the Tutorial1-IntroArcGIS, Part G  
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Project: Healthy Living in My Community Story Map 
For students 

 

This lesson was created by the Arctic Institute of Community-Based Research, borrowing the format of 
original assignments. 

  

Project Overview 

A story map is a great tool to communicate and share stories about the world and your experiences in 
it. They are a combination of maps, multi-media such as photos and videos, and text that are used to 
tell a story. Using the map(s) you created and skills you acquired in previous lessons, in this project, 
you will make a story map about Healthy Living in Your Community. You will put the plan you 
developed in Assignment 4 into action. Now that you’ve made your plan, go out and participate in the 
healthy living activity and then follow along the appropriate tutorials to help you complete the 
project: 

● Story maps tutorials: https://storymaps.arcgis.com/en/app-list/ 
 

Learn: 

● Once you’ve chosen which story map version you want to use, go through the tutorial and 
start creating your map! 

 

Act:  Create a Story Map 

Choose the type of story map you want to create and follow the appropriate tutorial: 

● Story maps tutorials: https://storymaps.arcgis.com/en/app-list/ 
How to combine previous maps created into one map: 

If you have not yet done so, you can walk through the following piece of the Tutorial 1 to learn 
how you can merge multiple maps (called “layers”) into one map – i.e. to combine maps that were 
created in Assignments 3 and 4 so that you can add them to your story map.  

• Follow the Tutorial1-IntroArcGIS, Part G  

How to embed other web content: 

● If you wish to embed (“add in”) other web content into your story map (sort of like copy 
and pasting content from one website to another or one web app to another):  
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Project: Healthy Living in My Community Story Map 
For students 

● Click “New section”; “new media” and then “link to content”; following that, copy and 
paste the website’s url; make sure you click “fill page” (so that the embedded content fills 
the full section); finally, click “configure” to complete. 
o For example, you may want to add in a section on the healthy living inventory to 

showcase, resources or factors that promote good health, here are the url links: 
▪ ‘AICBR: Healthy Living Inventory Map for Yukon’ - https://esricanada-

ce.github.io/aicbr/2016/#yt 

▪ ‘AICBR: Healthy Living Inventory Map for NWT’ - https://esricanada-
ce.github.io/aicbr/2016/#nwt  

See more on this in the tutorials. 
 
Save your story map: 
● Make sure to Save your story map every so often. When saving, make sure to include a title, 

description and tags (keywords) for your story map. Click the Done button.   

● Only after you’ve presented your Story Map to the rest of the class, share your story map 
with your teachers’ classroom Group in ArcGIS Online. With your teacher’s permission, you 
can share the story map with anyone in your school or community by adding the story map to 
a Website, or sharing it over social media. 

a. Click the Share button.  

b. Share your story map with the group set up by your teacher by clicking the box next to 
your selection.  
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Tutorial 1: Introduction to ArcGIS 
Online 

 

 
This tutorial was originally created by K12 team at Esri Canada and modified by the 
Arctic Institute of Community-Based Research for the Healthy Living in My Community 
Project. 

 

Tutorial Overview 

In this tutorial, you will be introduced to the basics of the ArcGIS Online web-based Geographic 
Information System (GIS) software tool. You will begin by exploring spatial data in the form of map 
layers that are available online as well as data in Web applications (apps). You will then use the ArcGIS 
Online Map Viewer to search for content, add features to a map and save and share your completed 
map with others.

Skills: • Search for content 
• Building a My Favorites page 
• Creating a Web map 

 • Search and add data 
• Create new map features 
• Changing symbology. 

Time Required: 60 – 75 minutes for the full tutorial (~10-15 minutes per Part) 

Materials 
Required: 

• An ArcGIS Online organization account. If you have not been given an account, 
speak with your teacher. Teachers - for information on joining an ArcGIS Online 
Organization, please visit www.esri.ca/agolaccess. For more information on 
ArcGIS Online, visit: www.arcgis.com.  

• Internet browser (e.g., Mozilla Firefox, Google Chrome, Safari, Internet Explorer). 
A video version of this tutorial is available at: https://youtu.be/tL6j0EDTFv0 
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Tutorial 1: Introduction to ArcGIS Online 
 

 
 

Part A: Getting Started 

There are many ways to find Web maps and apps and to search for and add data to a Web map in ArcGIS 
Online. In this part of the tutorial, you will explore one of the available search options within ArcGIS 
Online. 

1. Sign in to your ArcGIS Online account from www.arcgis.com. 

2. Select the Gallery button at the top of the home page. This page provides access to featured 
Web maps and apps that are available through ArcGIS Online. 

 
3. Explore a Web map or app from the Gallery. You can do this by moving your mouse over the 

thumbnails and clicking on Open  to view a map or app.   

4. Now you will search for maps and apps by using the search box located in the upper-right corner 

. Type in the search term “ArcCanada”. All content created by Esri Canada’s 
Education and Research staff is tagged with the metadata keyword “ArcCanada”. 

5. Turn off the switch next to “Only search in” your organization 
name by clicking on the button. This default limits your search to 
your own organization. Unchecking this box will allow you to 
search all the content in ArcGIS Online.  

6. Review the results that appear. Once you find content you want to explore, click on the 
thumbnail. 

 

7. To view more information about the content, click on the three dots and 
select View item details. The Details page includes a description of the 
content.  

8. Click on the star  to add this content to your My Favorites gallery. 

a. To see your favorites, click on Content at the top of the page, then 
click on the My Favorites tab. 
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Tutorial 1: Introduction to ArcGIS Online 
 

 
 

Part B: The Map Viewer 

Now that you have browsed through some of the many data layers and mapping apps that are available 
map in ArcGIS Online you will open the ArcGIS Online Map Viewer to create your first Web map and 
explore some of the features of the ArcGIS Online software tool.  

1. Ensure you are still Signed in to your ArcGIS Online account from www.arcgis.com. 

2. Click the Map button at the top of the ArcGIS Online home page. This will launch the ArcGIS 
Online Map Viewer. The Map Viewer is the default location for creating new or viewing existing 
Web maps and data within ArcGIS Online. 

 

3. Click on the Basemap button . You will see there is a good variety of available 
basemaps to choose from. The default map layer is the world Topographic basemap. Select a 
basemap by clicking on it and the map content will change. Keep in mind that you can change the 
basemap at any time during your use of ArcGIS Online. 

4. Locate the search box  in the upper-right corner of the Map 
Viewer. Use the search box to zoom to a location of interest. The search box can be used to 
locate countries, cities, specific addresses, institutions such as universities and even certain 
named monuments. For accurate search results, include as much information as possible, such as 
Address, City, Province and Postal Code. 
Note: It is important to note here that the search box in the Map Viewer is used to search for geographic 
locations on the map, NOT content on ArcGIS Online. 

5. You can also zoom in to an area of interest. There are two ways you can do this: 

a. Zoom by either using the scroll wheel on your mouse, or the + button that appears 
on the left side of the map. 

b. Hold down the Shift key and at the same time, left-click on your mouse and drag the 
cursor to draw a rectangle on your map to zoom into a specific area of interest 

Note: If you zoom in too far, you may receive a message saying ‘Map Data Not Available’. Zoom out until the 
map is properly visible. 

6. If you need to reposition the map, you can pan by left-clicking on the mouse, hold and drag the 
map to a new position, or use the arrow keys on your keyboard. 
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Tutorial 1: Introduction to ArcGIS Online 
 

 
 

Part C: Adding Features to your Map 

In this part of the tutorial, you will create a new map and add your own features to it. Think of 
something you would like to map. For example: favourite places, cities you would like to visit, or your 
route from home to school. 

1. In the top right-hand corner of the map viewer, click on New Map  and select Create 
New Map to clear the layers that you added. 

2. Click on the Add button  and select Add Map Notes.  

3. When the Map Notes window appears, ensure the Template is Map Notes, and update the Name 
field to represent the data you will be creating, for example, type in My Community. Click on 
Create. 

4. A list of features (Add Features window) has appeared to the left of your screen.  

5. A new Edit  button has also appeared at the top of the page. When this button is 
selected, the Add Features window will be displayed on the left side of the page. 

The Map Notes template allows you to add your own content in the form of notes 
attached to features on the map. A feature can be a point, line, or area (polygon) 
displayed on the map that you add descriptive popup information to including text, 
images, or links to Web sites. You can also add text, shapes, and other features 
directly to your map without a popup note.  

6. In the Add Features window, choose the Area  icon. 
Single click with the left mouse button on the map to start drawing the outline 
of a feature of interest. Make an additional left click for every change of 
direction and when you have entered the last change of direction double-click 
to close the area (polygon). 

a. Examples of areas that you could draw include:  

i. A park area, water bodies, a neighbourhood, a forest, and 
schoolyard.  

b. You can also add line and point features to your map using the 
appropriate icons in the Add Features window. Lines can represent 
roads, rivers, or hiking routes and are entered in the same way as areas 
with a double click to end the line. Points can represent the location of 
something (schools, trees, restaurants or community centres) and are entered with a 
single mouse click. 

To give additional meaning to the feature(s) you have created, you will now add attribute data to 
your features by writing about the feature. Additional information for map notes is displayed in the 
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form of popups that appear when a feature is selected by clicking on your map outside of an edit 
session.  

7. When you have finished drawing each of your feature(s), you will be presented with the attribute 
window. Use this window to add descriptive information, such as a title, description, an image, or 
URL for a relevant Web site. You can also configure the popup display by formatting the text or 
altering the colours used. If you are not satisfied with the feature that you added, you may 
remove it using the Delete button. 

Note:  If you accidently close this window, you can get back to it at any time by clicking on your feature while the 

Edit button  is active.   

8. Add a title and description to your pop-up. You can add hyperlinks to 

your description by using the Create Link  button. 

9. You can also add images to your pop-up. Images must come from the 
Internet (i.e. from a Web site, google images, or image repository such 
as Flickr) and be in JPEG, GIF, or PNG format.  

a. Find your image online – for example, go to Google.ca, search 
“Canada Games Centre”, press “Image” tab under search box; 

b. Find image you like, and right click with your mouse on 
the image; then click copy the image address; 

c. Go back to your map and in the map notes pop-up, paste 
it in the Image URL space. 

10. You can also add an image link, so that your image will be 
hyperlinked to a Web site (i.e. when in your map, you click on 
the image it will take you to the linked website). To do this, find 
the website link (for example, http://aicbr.ca) you want to add, copy it, and paste it in the Image 
Link URL space of the pop-up.  

11. Close the features attribute window when you are finished and it is automatically saved. 

12. Click on Edit  to leave your editing session. Click on the feature you just updated, and 
you should see the information and image you added in a popup. If you included an URL to link 
to, click on the image and see if it worked. 
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Part D: Symbolizing your Features 

In this part of the tutorial, you will alter the way your features are displayed on the map by changing the 
symbol, colour, outline, or transparency. Use these tools also to show similarities or differences between 
features. 

1. With the Edit button  still active, select an area feature that you created.   

a. In the attribute window, select the Change Symbol button .  

b. From here, you can select from a number of predefined colours.  Choose a colour for your 
feature and set the Transparency to 70%.  This will allow you to see any features that are 
hidden underneath your area feature. This is particularly useful if 
your area feature is large and obscures part of the underlying 
basemap or data layer. 

c. When you are finished, click OK. Click Close in the attribute 
window to return to your map. 

2. Select a line feature from your map and select Change Symbol. 

a. Chose a template that is appropriate for your line feature. For 
instance, you may represent a walking path by using a dashed 
line, while a river will be represented by a solid blue line.  

b. When you are finished, click OK. Click Close in the attribute 
window to return to your map 

3. Finally, select a point feature from your map and select Change Symbol. 

a. With point features, you can choose from a number of predefined templates from the 

drop-down menu , alter the size of the point, or even add 
your own image or icon to use for the point. 

b. To add your own image: Find the URL for an image that is hosted online. Copy the image 
location. Make sure the image is in JPEG, GIF, or PNG format.  

c. Click on Use an Image and then paste the selected link in the Use 
an Image space.   

d. Click Done when you have added the URL then click OK in the Change Symbol window 
and return to your map. 
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Part E: Adding Text to your Map 

In this part of the tutorial, you will add text directly to your map. This is useful if you are creating a map 
that you will be printing.  Use the text to label features, add a title, or annotate your map. 

1. With the Edit button  still active, select the Text feature from the Map Notes window. 

2. Single click with the left mouse button anywhere on the map to add a text box. When you are 
done typing your text, click Enter. 

3. To adjust the size and orientation of your text, click on the text. Squares 
will appear around your text. The top-middle box can be used to change 
the orientation of your text and the corner boxes can be used to change 
the size.  You can also change the alignment, colour, or add a halo using the Change Symbol 
menu that appears on the left-hand side of the screen. 

 

4. When you are finished adding text, unselect the Edit button and explore the features on your 
map. 
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Part F: Saving and Sharing your Map 

In this part of the tutorial, you will save and share your map. You will also learn how to find, organize, 
and edit your maps through the Content page.  

1. It is now time to save your map. Click the Save button located above your map, and 
select Save As. 

2. In the Save Map window, enter an appropriate title, summary, and a set of tags that will make 
your map easy for others to find if they search for it on the Internet. When you are finished, click 
the Save Map button. Your map is now saved to your ArcGIS Online account. 

Note: You can access your map by locating it within the Content section of ArcGIS Online.  

3. Click the Share button  located above your map. From the Share window that 
appears, you can do any of the following or you can keep your map private:  

• Select whom to share your map with. You can share it publicly and/or to a group (if you 
have one set up already). 

• Share your map using a unique Web URL:  

• Embed your Web map in a Web site: 

 

• Create your own customized Web app that uses your Web map:  

4. Click Done to exit the Share window. 

The Content page allows you to view and organize your content. This content is everything you have 
created and saved in your account. You can also create folders to help organize your data and Web 
maps. 

1. Select the Content button at the top of the page.  

2. Click the  icon to create a new folder and type ‘Tutorial Maps’ as the folder name. 

3. Under All My Content, click the check box  beside your recently created map to select it. A 

few options will appear at the top of the page, click the Move button  and select the 
Tutorial Maps folder as the folder to move this map to. 
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Part G: Search and Add Data Layers to your Map 

Go to your Content and open the map you created earlier (in Assignment 3). In the map viewer, you can 
also search for data layers to add to your map. What you can do is add to your original map, new 
mapping layers that you created through your survey in Assignment 4 You can also add other public 
data layers that others using ArcGIS Online have created. In this part of the tutorial, you will search and 
add different data layers to your map. 

1. In the map viewer, click on the Add button  and select Search for Layers.  

2. If you want to search only your content, to view previous maps 
you have created, make sure My Organization is selected in the 
In: field. Type in a keyword in the Find: field to find the map layer 
you are looking for. 

3. If you want to search other ArcGIS users’ map layers, you can 
add those to your map as well. Ensure that ArcGIS Online is 
selected for the In: field. You may also want to uncheck the box 
next to Within map area.  

Some keywords you can use to find other public content include: 

a. “ArcCanada” (data include: Canada’s Climate, Earth’s tectonic plates, natural events, 
Canada’s population density, and much more). 

b. “Livefeed” (data include: Wind speed, Earthquakes, Hurricanes). 

c. “World Bank” (data include: economic and social indicators like GDP, 
education levels, and age and population). 

Adding other public map layers just allows you to add further content and context to 
your map. It is not required that you do this however for this assignment.  

4. Once the results of your search appear, explore the layers in the results 
window. From here, you can click on the layer title for more information or 
click Add to add the data layer to your map. 

a. Choose a layer to add to your map. You can add more than one layer 
at a time. 

b. Once you are finished adding layers, click on Done Adding Layers . You 
can add data again at any time.  

c. You can turn a layer off by unchecking it in the Content section. If you would like to 
remove completely a layer from your map, hover over the layer name, select the More 
Options  icon and click on Remove. 

The data used in the example below are the Canada’s Climate created by EsriCanadaEd. 
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5. Click on the layer name. Note that some layers require you to 
click below the title layer when it appears in the Content 
section because there may be multiple layers to choose from, 
as shown in the first screenshot to the right. Click on the layer 
name that is selected (Annual Mean Temp) to view the legend, 
as shown in the second screenshot. 

6. Change the data displayed on your map by unchecking the data 
layer you want to turn off, and checking the box next to the 
data layer you want to turn on. 

7. Save your map (see Part E).  

Other Skills  
Want to learn how to measure distance and area in ArcGIS Online? Check out the “Measuring Features in ArcGIS 
Online” tutorial: http://bit.ly/2uBq8ZT  
 
Want to learn more about creating filters (queries) so you can see a subset of your data and conduct analysis on 
your map? Check out the “Using Tables and Filters” tutorial: http://bit.ly/2uBqZdb  
 
Want to learn more about creating custom Web applications? Check out the “Creating Web Applications” 
tutorial: http://bit.ly/2prBWYv   
 
Search for more K-12 tutorials and lessons at k12.esri.ca/resourcefinder . 

© 2017 Esri Canada. All rights reserved. Trademarks provided under license from Environmental Systems Research Institute Inc. Other product and 
company names mentioned herein may be trademarks or registered trademarks of their respective owners. Errors and omissions excepted. This 
work is licensed under a Creative Commons Attribution-NonCommercial-ShareAlike 4.0 International License. The Education and Research Group 
at Esri Canada makes every effort to present accurate and reliable information. The Web sites and URLs used in this tutorial are from sources that 
were current at the time of production but are subject to change without notice to Esri Canada. 
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This tutorial was originally created by K12 team at Esri Canada and modified by the 
Arctic Institute of Community-Based Research for the Healthy Living in My Community 
Project. 

 

Tutorial Overview 

In this tutorial, you will learn how to create a survey using the Survey123 for ArcGIS Web designer, 
submit data, and create a Web map to share survey results. 

Skills: • Creating a survey in the Survey123 web designer. 
• Submitting survey data. 
• Creating a Web map in ArcGIS Online. 

Time Required: 30 – 45 minutes 

Materials 
Required: 

• An ArcGIS Online organization account. If you have not been given an account, 
speak with your teacher. Teachers - for information on joining an ArcGIS Online 
Organization, please visit www.esri.ca/agolaccess. For more information on 
ArcGIS Online, visit: www.arcgis.com.  

• An electronic version of this tutorial is available at http://bit.ly/2qrziVq.  

 

Part A: Determine your Questions 

Before you begin to build your survey, think carefully about the type of questions you would like to ask 
about key healthy living features in your community. Complete this tutorial once you’ve drafted your 
questions. 

 
Determining these questions in advance will assist with creating a well thought-out and useful survey in 
terms of the answers that it will provide you with.   
 
Part B: Create and Configure a Survey 

In this part of the tutorial, you will create a survey using the Survey123 Web 
designer. 

1. Sign in to your ArcGIS Online account from www.arcgis.com. 

2. Click the Apps button in top right corner and choose Survey123 
for ArcGIS. This will open a new tab in your browser.  

3. Click Create New Survey and Get Started Using the Web designer.  
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4. Give your survey a Name, Tags, and a Summary. You can change the thumbnail of your survey by 
clicking on Thumbnail and uploading a relevant image to make your survey easier to find. Click 
Create. 

Note: Remember the name you assigned to your survey because a folder will be created with the 
same name in your My Content area of ArcGIS Online once the survey is published. 

 

5. Your survey will open in the Design tab . This is where you will create your survey 
questions. Think about the questions you would like to ask and decide which question type is 
best suited to collect the most meaningful answers for that question.  

Note: The GeoPoint provides a map for the user to select a location 
that will display in ArcGIS Online. For instance, if you are collecting 
data about active living program/areas in your community, include 
a GeoPoint question so the user can tell you the location of each 
specific feature or activity that relates to active living. You must 
have a location question in your survey in order for the data to be 
mapped properly. 

a. Add your first question.  

  
b. Click on your question to activate the Edit tab. You will see a list of customizable 

properties. Add your own question. 

 

 

 

Note: The Edit tab will look slightly different for each question type. Below is a summary 
of common properties that you will customize for each question:  

Label: Type in the question you want answered here.  

Hint: Provide a hint to tell the user how to answer this 
question. 
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Choices: Depending on the question type, you will 
provide a list of choices for the user to choose from.  

Validation: Increase data accuracy by limiting the way a 
question is answered. For instance, setting a min. and 
max. value and making a question required. The user will 
not be allowed to submit the survey without answering a 
required question. 

 

c. To add more questions, click on the Add button  and select a question type. Follow 
Steps 5a-b to activate the Edit tab and change the question properties. 

6. You have the option to set visibility rules to make the visibility of some questions conditional on 
the answer to a prior question. Visibility rules can be added to Single Choice or Dropdown type 
questions. 

a. For instance, if you are collecting data on active living programs/areas in your community 
you may have the following two questions:  

1. Is the program/area free? (answer 
options: Yes/No/Unsure) 

2. If No, how much does it cost?  

You may want Question 2 to appear only if the 
user selected No as the answer to Question 1. 
To do this, click Set Rule  on Question 1. A 
popup will appear that allows you to set the visibility rules for other questions. Under If 
you will select the answer (in this case, ‘No’). Under Show, you will select the question 
that will appear when the answer specified under If is selected (in this case, ‘If No, how 
much does it cost?’).    

b. Repeat this process with other questions you wish set visibility rules for. 

7. Once you are done making your survey, you can preview your survey by clicking Preview 

 at the bottom of the page. Here you can preview how your survey will look on 
various devices to the end user. Close the preview, make any necessary changes to your 
survey, and click Save.  

8. When you are ready to publish your survey, click Publish  at the bottom of the page. 
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Part C: Share your Survey & Collect Data 

In this part of the tutorial, you will share your survey so that you and others can submit data to your 
survey. 

1. Before you begin data collection, you will specify who can fill out your survey. 

a. Click on the Collaborate tab  and Submitter  to choose who can submit 
data to the survey. 

Note: Choosing Everyone (Public), allows anonymous users to submit to the survey, even those 
without an ArcGIS Online account. This can be beneficial if you are going to send the link to 
friends/family/neighbours outside your classroom. They then can fill out your survey without 
having an ArcGIS Online account. Alternatively, you might want to just share it to your teacher’s 
classroom group and then fill in the survey yourself (you can still ask your 
friends/family/neighbours the questions, you will just have to input their answers.) 

b. Once you’ve made your selection, click Save . You and the selected users will now 
be able to submit your survey.  

c. You can also choose who can view the results of the survey in Viewer and specifying 
which audiences you want to share your survey results with. 

d. Once you’ve made your selection, click Save . You and the selected users will now 
be able to view the results of your survey.  

 

2. Share your survey via the Survey Link or the QR code found at the bottom of the Collaborate tab.  

 

 

 

a. Under the Collaborate tab, choose to 
open the survey in a Web browser. 

 

3. To collect data: 

a. Open the Survey Link in a web browser.  

b. Fill out the survey. When you are done answering all questions, click Submit. 

Note: If you shared your survey with Everyone (Public) in Step 1a, anyone who visits the 
Survey Link can submit to your survey without logging in. If you selected Members of my 
organization or Following Groups, users will be prompted to log in using their ArcGIS 
Online account to view and submit to your survey. 
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Part D: View Survey Results 

In this part of the tutorial, you will view your survey results in Survey123 and create and save a Web 
map in ArcGIS Online.  

1. To track the status of your survey and view the survey results, Sign In with your ArcGIS Online 
account, click the Apps button, and choose Survey123 for ArcGIS.   

a. Under the Surveys I own page, find your survey and click the button which brings you 

to the Analyze tab .  

b. Here, you can see the results of your survey by viewing the 
individual answers to each question. To see the data update in 
real-time, simply refresh the page periodically. 

c. Depending on the question type, you will be able to change the 
view of the data by selecting the different options in the top right-
hand corner of each question box. Each question type will have 
different view options (Column, Bar, Pie, Map, etc).  

2. Optional: To download your data or to see your data on a map, click the 

Data tab  .  

a. Here you can see your data represented on a map as well as in a 
table. To download your data, in the bottom right-hand corner of 
the page select the format you require (CSV, Shapefile, or File 
Geodatabase), and click Download. 

Note: If you included a GeoPoint question, the points on the map 
correspond to the location the respondents chose. If you did not include a GeoPoint 
question, the points on the map correspond to the location of the device that the 
respondent used to submit the survey. 

3. Open your map in ArcGIS Online by clicking Open in ArcGIS Map Viewer  
found under the Data tab. 

a. You can customize the look of your map by clicking  to change the symbology, and
 to change the basemap. 

b. Save your map by clicking Save .  

c. Click Share  to share your map containing the results of your survey with the public or 
members of your organization as a map, Web app, or story map. 
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